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1.0 INTRODUCTION 
 

The purpose of PhotonExcel add-in is to provide a simple interface between Excel and 
users for calculation of photon (gamma & X-ray) emission from any radioactive source. 
A simple interface provides users with a fast way to insert data on gamma/X-ray lines 
(energies & probabilities) and the physical constants into Excel for conducting 
calculation in dosimetry and shielding using all of the tools Excel has to offer. This add-
in also allows users to quickly obtain such characteristics as activity, specific doses, 
decay products, attenuation and absorption coefficient for the selected element or 
compound. 
 
It creates an additional Excel Tab called ‘Physics’: 
 

 
Figure 1 Selection of Physics Tab in Excel 
 

2.0 STRUCTURE AND FUNCTIONS 
 

 

  The functions of each button (from left to right) are as follows: 

 

 

This button cycles between atomic number, element symbol and element 

name of any chemical element from the Periodic Table 

 

 

Calculates an activity in Becquerels from a mass in grams   
 

 

 

Converts a mass in grams to an activity in Becquerels.   
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Provides the half-life in seconds 

 

 

Provides all emission lines (gamma+X-rays) of the selected element, i.e. 

energies in eV and probability in part fraction 

 

 

Provides gamma emission lines of the selected element, i.e. energies in 

eV and probability in part fraction 

 

 

Provides X-ray emission lines of the selected element, i.e. energies in eV 

and probability in part fraction 

 

 

Defines the minimum energy to be considered in photon spectrum  

 

 

Calculates the decay products of the selected isotope over selected time 

period 

 

 

Calculates the mass specific dose of the selected element at 1m in 

Sv(gh) -1  

 

 

Calculates the activity specific dose of the selected element at 1m in 

Sv(Bqh) -1 

 

 

Calculates mass attenuation coefficient for the selected element or 

compound in cm2g-1 

 

 

Calculates mass energy absorption coefficient for the selected element or 

compound in cm2g-1 

 

 

Loads the table of build-up factors into the program’s memory 

 

 

Retrieves an interpolated value of build-up factor B(E,μd) 

 

 

Create a file suitable for input to MCNP program 

 Inserts the mathematical constant π = 3.141592654 



PhotonExcel Add-in Version 3 DOC. No: PSDExUM-0003-A 
                                                                            PhotonExcel User Guide REV: 1
 PAGE 6 OF 24 

 Inserts the physical constant Speed of Light C = 3E+08 m/s  

 Inserts the physical constant of Electron Charge e = 1.60218E-19C 

 Inserts the Gravitational constant G = 6.67384E-11 Nm2kg-2 

 
Inserts the Avogadro constant NA = 6.02214E+23 mol-1 

 Inserts the Boltzmann constant k = 1.38066E-23 J/K   

 Inserts the Electric constant ε0 = 8.85419E-12 Fm-1   

 Inserts the Magnetic constant  μ0 = 1.25664E-06  H m-1   

 
Inserts the Plank constant h = 6.62608E-34 Js 

 Inserts the Stefan–Boltzmann constant σ = 5.67037E-08 W/m2K-4 

 
Inserts the fine-structure constant α = 0.007297353 

 
Inserts the Rydberg constant R∞ = 10973731.57 m-1 

 
Inserts the Atomic Mass constant u = 1.66054E-27 kg 

 
Inserts the physical constant of Proton Mass mp  = 1.67262E-27 kg 

 
Inserts the Electron Mass constant me = 9.10938E-31 kg 

 

 

 

3.0 GENERAL FUNCTIONALITY (PHYSICS TAB) 
 

Data input to the functions is most easily done by selecting a row of cells and clicking on 
the relevant button in the Physics tab. Different function buttons require differing number 
of cells to be selected. Buttons requiring one cell selection include all physical 
constants, the “Number-Symb-Name” function and the minimum energy function. The 
other function buttons require more than one cell to be selected. The data input 
information required must be placed in cells on the left-hand side and answer/ result of 
calculation will be placed on the far right column of your selection. 
 
Figures 2 & 3 show screen shots depicting the action of selecting data and then 
inserting a function. In this case Uranium 238 with isomeric state 0 is the isotope, the 
data quantity is 1, clicking the Activity Button performs the calculation of deriving the 
activity in Becquerels for an input quantity of 1 gram. Figure 3 shows the answer in cell 
“F1” following the button click. The answer was inserted incell “F1” because “F1” was 
the far right hand cell of the initial data selection shown in figure 2. 

https://en.wikipedia.org/wiki/Joule
https://en.wikipedia.org/wiki/Kelvin
https://en.wikipedia.org/wiki/Joule
https://en.wikipedia.org/wiki/Kelvin
https://en.wikipedia.org/wiki/Kelvin
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Figure 2 Example of Data Selection Before Pressing the Function Button 
 
 
 

 
Figure 3 Screen Shot After Clicking on the Activity Button. 
 
 

3.1 General Data Input Rules 
 

Select a Data Input Block  
The left hand column in the selection must contain an element number, symbol or 
name.  
The next column on the left must contain the atomic mass.  
The third column on the left should contain isomer information or remain blank.  
The fourth column should contain an quantity data such as mass (g) or activity 
(Bq).  
The result will be placed in the far right hand column selected.  
For complex data types (emission lines, decay products etc) the result will be 
presented in a new worksheet. 
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3.2 Specific Input Rules for the Decay Routine 
 

The “Derive Decay Products” routine has special data input rules. For this function a two line 

data input selection is required. Figure 4 shows an example of data input to calculate the decay 

products of Uranium 238 (Isomer 0) from a period starting in 1000s up to an end period of 

1E+18 seconds or 3E+10 years. The results will be displayed in a new worksheet, decay 

product will be displayed in columns with ten lines of decay data (Number of Lines Input = 10). 

Output will displayed as mass in grams (Data Type Input = 1). 

 

 
Figure 4 Decay Function Data Input 

 

 

 
Figure 5 Result of the Decay Function (Number of Lines = 10) 
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Should the “Number of Lines” input value be set to 1 then the results format is slightly different 

with only the final value being displayed in a set of rows. See example of this mode in figure 6. 

 

 
Figure 6 Result of the Decay Function in Alternative Output Format (Number of Lines = 1). 

 

The decay routine can accept more than one isotope as an input hence a mixture of substance 

can be decayed. Figure 7 gives an example of the input selection for a mixture that contains 

both uranium and thorium isotopes. 

 

Specifically: 10 grams of Uranium 238, 2 grams of Uranium 235, 1.2 grams of Thorium 230 and 

1.5 grams of Thorium 234. 
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Figure 7 Input of a mixture for the decay routine. 

 

3.3 Creating MCNP SDef Files 
 

Rules are similar to the general rules for data input. Select the input isotope data, most 

left column for element number, the next column on the right for atomic number the next 

for isomer number and finally the quantity that should be presented in grams. Figure 8 

shows an input selection example for a mixture of 3 grams of Cs-134 and 2 grams of 

Co-60. 

 
Figure 8 Input Selection for MCNP Sdef Creation 
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After selecting the input data, press the “Create MCNP SDef File” button in the Physics 

Tab. The file is created and a “Save File” dialog box is opened to allow the naming of 

the mcnp output file. Figure 9 shows the screen following clicking on the mcnp button, 

note the mcnp weighting is placed in the far right hand column of the data selection. 

Type in the file name and click save as usual windows file saving procedure. The file is 

created as a text file making it easy for the MCNP SDef code to be copied and paste 

into MCNP input text files. The output file includes a record of the isotope mixtures and 

the photon energy list. The actual SDef code is included at the end of the file following 

the isotope record. 

 

 
Figure 9 Creating MCNP SDef text files 
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4.0 GENERAL FUNCTIONALITY (FORMULAS TAB) 

4.1 Physics Constants 
 

From version 3 onwards some physics functions are included in the Formulas Tab of the 
Excel spreadsheet. The Physics constants are available via a constants button in a new 
Physics Group. Just click on the constants button to get a drop-down list of the 
constants available. 
 

4.2 Lookup and Reference 
 

From version 3 onwards some physics functions are included in the Formulas Tab of the 

Excel spreadsheet. Some of the functions that require data input, such as isotope 

information, are listed in the “Lookup and Reference” section of the function library. Click 

on the Lookup & Reference button and select the required function from the drop-down 

list. Fill in the data input boxes as in the usual Excel function method. 
 

5.0 CALCULATION EXAMPLES 
 

5.1 Example A Dose Rate Calculation 
 

Find the equivalent gamma dose rate from 1 MBq of Co-60 at 1 metre. 
 
We will use the following formula for a gamma dose: 
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where A is the activity of the source, R is the distance in cm, Ei and Pi the gamma 
emission energy and emission probability per disintegration respectively;  (μt /ρ)tis 
is the absorption coefficient for tissues. The summation must include all emission 
lines.  
 
1. Type element symbol ‘Co’ in the cell A1 (or atomic number ‘27’, or element 
name ‘Cobalt’) and press Enter; 

 
2. Enter ‘60’ in the B1 cell; 
3. Enter the isomeric state in C1, in this example there is no isomeric state and 
C1 can be left blank; 
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4. Drag cursor to select 2 cells (in case of isomer 3 Cells) A1+B1(+C1) together 

and press ‘All photons’ button  
 

 
5. A new worksheet ‘Photons 1’ will be opened consisting the six gamma 
energies in eV in the column B and their emission probabilities in the column C; 

 

 
Figure 10 “Sheet 1” : Steps 1 – 4 
 

 
Figure 11 “Photons 1” : Step 5 
 

6. Enter an absorbing material ‘tissue’ in the column A 
 

7. Select the cells from A2 to D7 and press ‘Mass energy absorption’ button 

 Column D will show tissue absorption coefficients in cm2g-1; 
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Figure 12 “Photons 1” : Steps 6 & 7 
 
8. In E column write a formula ‘=B2*C2*D2/1000’ to find a term under the sign of 
summation; 

 
9. Sum the data in E column and place an answer at E8 cell; 

 
10. Multiply the result of summation by activity A=106 Bq and coefficient 5.77e-4 
and place an answer at F8 cell: ‘=E8*1000000*0,000577’ 

 
11. Finally divide by 4πR2;  where R=100 cm and place the result in cell G8: 

‘=F8/(4*3,142*100^2)’. 
 
The result is 0.337 μSv/h 
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Figure 13 “Photons 1” : Steps 8 - 11 
 

There is another short way of calculation of the gamma dose rate. 
 
1. Repeat steps 1-3 

 
2. Drag cursor to select 3 cells (in case of isomer 4 sells) A1+B1+C1(+D1) 

together and press ‘Activity Specific Dose’ button  
 

 
3. The result gives the activity at 1 metre in Sv / (Bq*h) in the cell C1. 

 
4. To account for 1 MBq and to change Sv to μSv we multiply by 1.e12 and 
place a result into D1 cell.  

 
 

 

 
Figure 14 “Sheet 1” : Using the “Activity Specific Dose” Button. 
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5.2 Example B Shielding Replicate the co60example.xlsm See Web Site 

 

Based on the previous calculations, find the dose rate from the same source of Co-
60 at 100 cm distance, when 3 cm thick lead shield is added between the source 
and detector. 
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This formula has additional terms under summation sign:  

build-up factor B(μd) as a function of mean free path μd, where d=3 cm is shield 
thickness and μ is attenuation coefficient. 

 
1. Repeat steps 1-9 from Example A & Type Column Titles in cells D1 & E1. 

 

 
Figure 15 “Photons 1” : Example B Step 1 

 
2. Add some shield data in Cells B11, B12 & B13, name these cells Thickness, 
Density & Geometry respectively, see Figure 16. 
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Figure 16 “Photons 1” : Step 2 
 
 
 

 
Figure 17 “Photons 1” Step 3 
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3. Place the formula “=E8*Geometry” in Cell E9, which will give the unshielded 
dose rate. Select Cells B1 to B10 and click “Insert” in the Home Tab to add a new 
column B and input a shield material name ‘lead’. 

4. Select B2-G7 cells and click ‘Mass attenuation’ button  Mass attenuation  
coefficients will appear in column G. Place a column tile in cell G1. 

 
5. Select Cells C1 to C10 and click “Insert” in the Home Tab to add a new 
column C and calculate mean free path μd ‘= Thickness*Density*(H2 to H7)’ 
 
6. Create your own table of build-up factors for the relevant shield material in a 
new worksheet. The first row (from Row 1 Column B and across) should contain 
the energy divisions in MeV starting from the highest and working down. The first 
column (from Row 2 Column A and downwards) should contain the mean free path 
divisions starting from zero. The build-up factors are then placed into the table from 
Cell B2 onwards, see example figure 19. Build-up factors can be obtained from 
various sources on the web, including links on the Photon Excel site. 

 
 
 

 
Figure 18 “Photons 1” : Steps 4 & 5 
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Figure 19 “Buildup Pb” : Step 6 Example Build-Up Factor Table 

 

7. Select all cells of the build-up table and press the button ‘Load table’ . A 
message informing of the correct loading of data should appear. 
8. Return to your previous worksheet “Photons 1”, select cells C2-I7, and press 

‘Get Build-up’  Interpolated Build-up factors will appear in column I, place title 
in Cell I1. 

 
 
 

 
Figure 20 “Photons 1” : Steps 7 & 8 
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9. Calculated the Shield Attenuation = EXP(-(H2 to H7) * Density * Thickness)  
and place in column J. 

 
 

10. Calculate the dose rate contributions columns d * e * f * I * j / 1000 and place 
in column K. 

 
 

11. Sum the dose rates of column K into Cell K8 
 
 

12. Multiply the summed dose rates by the geometry factor and placed in Cell K9  
(K9 =  K8 * Geometry). Result of shielded dose rate is produced as 0.077µSv/hr. 
 
 
 
 

 
Figure 21 “Photons 1” : Steps 9 & 10.  

 
 

 
Figure 22 “Photons 1” : Final Result 
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6.0 INSTALLATION INSTRUCTIONS FOR WINDOWS 
 

1. Download the Spreadsheet “Photonexcelv003.xlsm” Can be copied and used 
anywhere on the installation computer. 

2. Download the dynamic link library “PSDExSm001.dll” and save to a 
temporary location. 

3. Start the spreadsheet. There may be a Macros Disabled warning, You need 
to click on the “Enable Content” button, see fig 23 

 
Figure 23 Macros Disabled Warning 

 

4. The Program will give two further warnings about licensing the product and 
finding the dll, figures 24 & 25. 

 

 
Figure 24 Product not Licensed Warning 

 



PhotonExcel Add-in Version 3 DOC. No: PSDExUM-0003-A 
                                                                            PhotonExcel User Guide REV: 1
 PAGE 22 OF 24 

 
Figure 25 DLL Not Found Warning 

 

5. The next step is to install the DLL. The DLL not found warning box also gives 
a location where the program is looking for the file. In figure 25 the location is 
C:\Program Files (x86)\Mircosoft Office\Office14\. Place the DLL file into the 
location advised by the warning message. 

6. Restart the spreadsheet and if all is well the program will start with just one 
warning about licensing (Fig 24). The software should now show the Physics Tab 
with most functions enabled. Those functions that are disabled will require a 
license file. 

7. To obtain a license file click on the “Get Product License” button under the 
Physics Tab and follow the instructions. 

8. Once the license file has been obtained, it should be placed in the location 
advised by the warning message. 

9. The Excel add-on consists in a series of routines written in the C++ language 
which are implemented as Windows dynamic link libraries (dll).  
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7.0 APPENDICIES 
 

7.1 Appendix A : List of Built-in Absorbing Compounds 
 
 
№             Name 
---------------------------------------------------- 
120  "A-150 Tissue-Equivalent Plastic" 
121 "Adipose Tissue" 
122 "Air" 
123 "Alanine" 
124 "Bakelite" 
125 "Blood_Whole" 
126 "Bone-Equivalent Plastic" 
127 "Bone_Cortical" 
128 "Brain_Grey-White Matter" 
129 "Breast Tissue" 
130 "C-552 Air-Equivalent Plastic" 
131 "Concrete_Barite" 
132 "Concrete_Ordinary" 
133 "Eye Lens" 
134 "Gafchromic Sensor" 
135 "Glass_Borosilicate" 
136 "Glass_Lead" 
137 "Lung Tissue" 
138 "Muscle_Skeletal" 
139 "Ovary" 
140 "Photo Emulsion (Kodak Type AA)" 
141 "Photo Emulsion (Stand_ Nucl_)" 
142 "Plastic Scintillator" 
143 "Polyethylene Terephthalate_Mylar" 
144 "Polyethylene" 
145 "Polymethyl Methacrylate" 
146 "Polystyrene" 
147 "Polytetrafluoroethylene_Teflon" 
148 "Polyvinyl Chloride" 
149 "Radiochromic Dye Film (Nylon Base)" 
150 "Tissue-Equivalent Gas (Methane)" 
151 "Tissue-Equivalent Gas (Propane)" 
152 "Tissue_Soft (ICRU Four-Component)" 
153 "Tissue_Soft (ICRU-44)" 
154 "Water"



Commissioning Philosophy for Dungeness A           DOC. No: 61050012-000-000/111.S/0005 
MXD Plant Upgrade                REV: 03 
    PAGE 24 OF 24 
 
   


	1.0 INTRODUCTION
	2.0 STRUCTURE AND FUNCTIONS
	_Toc433912859
	_Toc433912860
	3.0 GENERAL FUNCTIONALITY (PHYSICS TAB)
	_Toc433912861
	3.1 General Data Input Rules

	_Toc433912862
	3.2 Specific Input Rules for the Decay Routine

	_Toc433912863
	3.3 Creating MCNP SDef Files

	_Toc433912864
	4.0 GENERAL FUNCTIONALITY (FORMULAS TAB)
	4.1 Physics Constants
	4.2 Lookup and Reference

	5.0 CALCULATION EXAMPLES
	5.1 Example A Dose Rate Calculation

	_Toc433912865
	_Toc433912866
	_Toc433912867
	_Toc433912868
	_Toc433912869
	5.2 Example B Shielding Replicate the co60example.xlsm See Web Site

	_Toc433912870
	6.0 INSTALLATION INSTRUCTIONS FOR WINDOWS
	_Toc433912871
	7.0 APPENDICIES
	7.1 Appendix A : List of Built-in Absorbing Compounds

	_Toc433912872
	_Toc433912873

